
Accessibility for Google Docs, Sheets, 
Slides & Drawings 
Google Docs, Sheets, Slides, and Drawings are designed to work with screen readers, braille devices, 
screen magnification, and more. 

Computer 

Use a screen reader 

If you already use screen reader software on your computer, such as ChromeVox, NVDA, JAWS, or 
VoiceOver, follow these steps to get started. 

Step 1: Turn on screen reader support 

The first time you use Google Docs, Sheets, or Slides with a screen reader, you need to turn on 
screen reader support: 

1. Go to Google Docs, Sheets, or Slides, and open a file. 
2. In the Tools menu, select Accessibility settings. 
3. Select Turn on screen reader support. 

Step 2: Check your screen reader settings 

For some screen readers, you might need to adjust your settings when you use Google Docs, Sheets, 
Slides, or Drawings. Check your screen reader instructions below. 

ChromeVox 

If you use ChromeVox on Chrome OS, you don't need to do any additional setup. 

NVDA 

On Windows, for the best experience, use the latest version of NVDA with the latest version of 
Chrome. 

Docs, Slides, and Drawings 

1. Go to Google Docs, Slides, or Drawingsand open a file. 
2. Listen for these words: "Screen reader support enabled." If you don't hear anything, go to the 

Tools menu, select Accessibility settings, then select Turn on screen reader support. You 
should hear "Screen reader support enabled." 

3. Press NVDA + Ctrl + k, then turn off Speak typed characters and Speak typed words. 
4. Optional: Change your NVDA startup keyboard shortcut so that it doesn't conflict with Docs, 

Slides, or Drawings. The default NVDA keyboard shortcut, Ctrl + Alt + n, is commonly used 
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in Docs, Slides, or Drawings (for example, Ctrl + Alt + n then g navigates to the next image in 
a document). To change your NVDA keyboard shortcut, open Properties from the NVDA 
shortcut. On the Shortcut tab, edit the Shortcut key so it doesn't conflict with Docs, Slides, or 
Drawings (for example, Ctrl + Alt + \). 

Sheets 

To get started in Sheets, simply turn on screen reader support as described in Step 1 above. 

Tip: Focus mode generally provides a better experience than browse mode. To switch between 
focus and browse modes, press NVDA + Spacebar. 

JAWS 

On Windows, for the best experience, use the latest version of JAWS with the latest version of 
Chrome. 

Docs, Slides, and Drawings 

For Docs, Slides, and Drawings, follow these steps to adjust your JAWS settings: 

1. Go to Google Docs, Slides, or Drawings and open a file. 
2. Listen for these words: "Screen reader support enabled." If you don't hear anything, go to the 

Tools menu, select Accessibility settings, then select Turn on screen reader support. You 
should hear "Screen reader support enabled." 

Sheets 

To get started in Sheets, simply turn on screen reader support as described in Step 1 above. 

Tip: Forms mode generally provides a better experience than virtual mode. 

VoiceOver 

Google Docs, Sheets, Slides, and Drawings are compatible with VoiceOver on the latest version of 
macOS. The recommended browser is Google Chrome. 

For the best experience, turn off VoiceOver's Quick Nav feature by pressing the left and right arrows 
at the same time. 

Docs, Slides, and Drawings 

1. Go to Google Docs and open a document. 
2. Listen for these words: "Screen reader support enabled." If you don't hear anything, go to the 

Tools menu, select Accessibility settings, then select Turn on screen reader support. You 
should hear "Screen reader support enabled." 

3. If you've turned on "Automatically speak the webpage" in VoiceOver, you'll hear the screen 
reader. Press Escape to return your focus to the editing area. 

4. Press VoiceOver + Shift + down arrow to interact with the editable text. 
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Sheets 

To get started in Sheets, simply turn on screen reader support as described in Step 1 above. 

Keyboard shortcuts and VoiceOver 

VoiceOver shortcuts conflict with menu shortcuts for Google Docs, Sheets, Slides, and Drawings. To 
open the menus, first use the VoiceOver pass-through keys Ctrl + Option + Tab, then type the menu 
shortcut, such as Ctrl + Option + f for the File menu. You can also quickly search the menus by 
pressing Option + / then searching for a term such as File. 

If VoiceOver doesn't automatically focus on the correct part of the page (for example, if a dialog 
window appears), press Escape to return your focus to the editing area. Then press VoiceOver + 
Shift + down arrow to return to the editing area. 

Recommended browser & screen readers 

Docs Editors recommends Chrome and: 

• NVDA or JAWS on Windows 
• ChromeVox on ChromeOS 
• VoiceOver on macOS 

Step 3: Start editing 

Learn more about using Google Docs, Sheets, Slides, and Drawings with a screen reader in the 
following help pages and videos. 

• Edit documents with a screen reader 
• Edit spreadsheets with a screen reader 
• Edit presentations with a screen reader 
• Edit drawings with a screen reader 
• Comment and collaborate with a screen reader 

Tip: In Docs, Sheets, and Slides, you can turn off the screen reader announcements about other 
people entering, editing, or leaving the file. Learn how to turn off collaborator announcements. 

Video tutorials 

Screen reader videos for Docs, Sheets, and Slides 
 
Getting started with Google Docs 
 
In this video, you’ll learn how to get started with Google Docs, using NVDA with Firefox. 
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Get started with Google Sheets 

In this video, you’ll learn how to get started with Google Sheets, using NVDA with Firefox. 

Get started with Google Slides 

In this video, you’ll learn how to get started with Google Slides, using NVDA with Firefox. 

Use a braille display 

You can use a braille display to read and edit documents, spreadsheets, presentations, and 
drawings. 

View files in high contrast mode 

You can view your documents, spreadsheets, and presentations in high contrast mode: 

• On ChromeOS, with high contrast mode 
• On Windows in Chrome, Firefox, or Edge browsers, with any of the Windows contrast themes 

Use Google Docs with a screen magnifier 

You can use a screen magnifier to zoom in as you move on a screen. 
Important: Screen magnifiers are available in Chrome. 

Mac: 

1. In the Chrome browser, open Google Docs. 

2. Under “Tools,” select Accessibility settings  Turn on screen magnifier support. 

If the magnifier doesn’t follow where you are onscreen, you might need to adjust your computer 
settings. To turn on the magnifier on your computer: 

1. In “System preferences,” select Accessibility  Zoom  Advanced. 
2. Turn on Zoom follows the keyboard focus. 

For more information, visit the Apple support article How to zoom in or out on Mac. 

Chrome OS: 

1. In the Chrome browser, open Google Docs. 

2. Under “Tools,” select Accessibility settings  Turn on screen magnifier support. 

To turn on the magnifier on your computer: 
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1. In “Settings,” select Advanced  Accessibility  Manage accessibility features. 
2. Turn on Enable fullscreen magnifier or Enable docked magnifier. Learn more about 

Chromebook magnification. 

Windows: To find out how to use the screen magnifier, visit the Microsoft support article Setting up 
and using Magnifier. 

Type with your voice 

You can type with your voice in documents or in presentation speaker notes. (This feature is only 
available in Chrome browsers.) 

Use keyboard shortcuts 

Google Docs, Sheets, and Slides include keyboard shortcuts for navigation and editing. 

To open a list of keyboard shortcuts while you're editing a file, press Ctrl + / (Windows, Chrome OS) 
or ⌘ + / (Mac). 

More keyboard shortcuts: 

• Docs shortcuts 
• Sheets shortcuts 
• Slides shortcuts 

Use touch input with a screen reader 

With some computers and screen readers, you can touch the computer screen to move the cursor 
and enter text. 

Touch input works in Docs, Sheets, and Slides using the following screen readers and browsers: 

• On Chromebooks, use the ChromeVox screen reader with Chrome 67 or later. 
• On Windows, use the JAWS screen reader with Firefox or the latest version of Chrome. 

Touch input with ChromeVox 

To use touch input with ChromeVox on a Chromebook: 

1. Check your Chromebook accessibility features for the following settings: 
• Turn off Enable select-to-speak. 
• Turn on Enable on-screen keyboard. 

2. Open a document, spreadsheet, or presentation. 
3. In the Tools menu, select Accessibility settings. 
4. Select Turn on braille support. 
5. In the editing area, use the on-screen keyboard. 
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6. Outside the editing area, swipe and touch the screen as you would normally. Learn about 
using Chromebook touch screen accessibility. 

Touch input with JAWS 

To use touch input with JAWS on Windows with Firefox or the latest version of Chrome: 

1. Open a document, spreadsheet, or presentation. 
2. In the Tools menu, select Accessibility settings. 
3. Select Turn on braille support. 
4. In the editing area, use JAWS Text Reading mode. 

• To cycle through the touch modes to Text Reading mode, use a two-finger rotate 
gesture. Learn about JAWS touch support. 

5. To move focus to the application menus, double-tap on the top of the screen. Use a three-
finger swipe or touch exploration to navigate. 

 

Android 
 

You can use Android accessibility features with Docs editors, including the TalkBack 
screen reader, screen magnification, and more. 

Use the TalkBack screen reader 

If TalkBack isn't already turned on for your Android device, learn how to turn on 
TalkBack. After you turn on TalkBack, use the tips below. 

Docs app 

Find a document 

1. Open the Docs app. 
2. Explore the app to find the document you want to read or edit. 

• New document menu: Use this menu to create a blank document or use a 
template. 

• Navigation drawer: At the top left, you'll find the navigation drawer. Open 
to explore options such as Recent and Shared with me. 

• Search: Search for a document. 
• Open document: Open from Google Drive or from your device storage. 
• More options: Explore options such as Sort by, Add new, or Refresh. 

Read a document 

1. Open the Docs app. 
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2. Move focus to the document, then double-tap to select. 
3. Swipe right to start reading the document. 
4. Optional: Change the granularity of your navigation within the document. 

• To navigate by characters, words, or paragraphs, swipe up or down. Then 
swipe right to continue moving in your document. 

• To navigate by lines, go to More options and select Print layout. Move 
your focus back to the document text, then swipe up or down until you 
hear the option to navigate by line. Then swipe right to continue moving in 
your document. 

5. To stop reading, tap the screen. 

Edit a document 

1. Open the Docs app. 
2. Move focus to the document, then double-tap to select. 
3. Move focus to the Edit button, then double-tap to activate. 
4. Explore the app to use the following edit controls:  

• Explore buttons and menus: Swipe right, left, up or down.  
• Adjust the granularity or control the cursor: Move focus to the document 

text, then swipe up then right to open the local context menu. 
• Use the on-screen keyboard: Drag your finger over the keyboard, and lift 

your finger to enter a key. 

Select and act on text 

1. Go to More options, then Selection control. 
2. From the menu, choose options such as Select, Select all, Copy, Cut, Paste, 

Comment, or Speak selection formatting. Options in the menu depend on what 
you've selected. 

Turn off collaborator announcements 

You can turn off the screen reader announcements about other people entering or 
leaving your document. 

1. Go to More options. 
2. Select Mute entries and exits. 

Sheets app 

Find a spreadsheet 

1. Open the Sheets app. 
2. Explore the app to find the spreadsheet you want to read or edit. 



• New spreadsheet menu: Use this menu to create a blank spreadsheet or 
use a template. 

• Navigation drawer: At the top left, you'll find the navigation drawer. Open 
to explore options such as Recent and Shared with me. 

• Search: Search for a spreadsheet. 
• Open spreadsheet: Open from Google Drive or from your device storage. 
• More options: Explore options such as Sort by, Add new, or Refresh. 

Edit a spreadsheet 

1. Open the Sheets app. 
2. Move focus to the spreadsheet, then double-tap to select. 
3. Move focus to a cell to read it, then double-tap to edit. 

Select a cell or range 

1. Open the Sheets app. 
2. Move focus to the spreadsheet, then double-tap to select. 
3. Go to More options, then Select cell or range.  
4. Double-tap to activate the edit field. 
5. Enter a cell (C3) or a range separated by a colon (R4:R10) . 
6. Select OK. 

Change announcements 

1. Open the Sheets app. 
2. Move focus to the spreadsheet, then double-tap to select. 
3. Go to More options, then Accessibility settings.  
4. To choose which properties are announced, turn on Read formatting properties.  

• Optional: Turn on or off verbalization of text formatting, cell formatting, 
number formatting, and fonts. 

5. To hear collaborator changes, turn on Read collaborator changes. 

Change cell formatting 

1. Open the Sheets app. 
2. Move focus to the spreadsheet, then double-tap to select. 
3. Move focus to the cell, then double-tap to select.  
4. Explore by touch to use the formatting buttons in the toolbar. 

Slides app 

Find a presentation 

1. Open the Slides app. 



2. Explore the app to find the presentation you want to read or edit. 
• New presentation menu: Use this menu to create a blank presentation or 

use a template. 
• Navigation drawer: At the top left, you'll find the navigation drawer. Open 

to explore options such as Recent and Shared with me. 
• Search: Search for a presentation. 
• Open presentation: Open from Google Drive or from your device storage. 
• More options: Explore options such as Sort by, Add new, or Refresh. 

Read a presentation 

1. Open the Slides app. 
2. Move focus to the presentation, then double-tap to select. 
3. Swipe right to start reading the presentation. 
4. Use these tips to navigate: 

• Move focus: Swipe right or left. 
• Move to next or previous slide: Two-finger swipe left or right. 
• Zoom in or out: Two-finger pinch. 
• Pan the canvas: Drag two fingers across the screen. 

Select, edit, and deselect shapes  

1. Open the Slides app. 
2. Move focus to the presentation, then double-tap to select. 
3. Move focus to the shape or group, then double-tap to select. 
4. To edit the selected shape, double-tap again. 
5. To deselect all shapes, move focus to the canvas, then double-tap. 

Move a shape 

1. Open the Slides app. 
2. Move focus to the presentation, then double-tap to select. 
3. Move focus to the shape. 
4. Double-tap and hold until you hear "Drag to move shapes."  
5. Drag your finger to move the shape. 

Rotate a shape 

1. Open the Slides app. 
2. Move focus to the presentation, then double-tap to select. 
3. Move focus to the shape, then double-tap to select. 
4. Swipe right until focus reaches the rotation handle. 
5. Double-tap and hold until you hear "Drag to rotate shapes."  
6. Drag your finger to rotate the shape. 



Turn off collaborator announcements 

You can turn off the screen reader announcements about other people entering or 
leaving your presentation. 

1. Go to More options. 
2. Select Mute entries and exits. 

Use keyboard shortcuts 

If you use an attached keyboard with your device, you can use keyboard shortcuts with 
the Docs, Sheets, and Slides apps. For a list of Android shortcuts, refer to Docs 
shortcuts, Sheets shortcuts, and Slides shortcuts. 

Use a braille display 

In the Docs and Slides apps, you can use a braille display to read and enter text. Learn 
about braille support. 

 
 
iPhone & iPad 
 

Use the VoiceOver screen reader 

You can use the VoiceOver screen reader with the Docs, Sheets, and Slides apps on 
iPhones and iPads.  

If you haven't already turned on VoiceOver, visit the Apple help site for instructions. 

After you turn on VoiceOver, use these common gestures to navigate in Docs, Sheets, 
and Slides apps: 

• Tab through controls: Swipe left or right 
• Activate the focused item: Double-tap  
• Move quickly to the top of the screen: Two-finger swipe up 
• Close a pop-up window: Swipe in a circle, then double-tap 

Docs app 

Use the rotor to navigate or edit 

1. Rotate two fingers to hear options for navigating and editing. 
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2. Swipe up and down or double-tap, depending on the currently selected option. 

Select and act on text 

1. Go to More options, then Selection control. 
2. From the menu, choose Select, Select all, Copy, Cut, Paste, Comment, or Speak 

selection formatting.  

Sheets app 

Select a row or column  

1. Explore by touch until you hear the row or column number you want to select. 
2. Double-tap to select the focused row or column. 

Change announcements 

1. In the toolbar, select Accessibility settings. 
2. Turn on Read formatting properties.  
3. Turn on or off verbalization of text formatting, cell formatting, number 

formatting, and font properties. 

Slides app 

Navigate in a presentation 

• Move focus: Swipe right, left, up, or down 
• Move to next or previous slide: Three-finger swipe left or right 
• Zoom in or out: Two-finger pinch 
• Pan the canvas: Drag two fingers across the screen 

Select a shape or group  

• Select shape or group: Move focus to the shape or group, then double-tap 
• Select a grouped shape: Move focus to the shape, then triple-tap 
• Edit selected shape: Double-tap  
• Edit text in a shape: Select the shape, then double-tap (for ungrouped shapes) or 

triple-tap (for grouped shapes)  
• Deselect all shapes: Move focus to the canvas, then double-tap 

Select multiple shapes 

1. Select a shape. 
2. Double-tap and hold until you hear "Entered multi-select mode."  



3. To add or remove a shape from the selection, move the focus to the shape, then 
double-tap. 

4. To exit multi-select mode, go to the "Exit multi-select mode" button and double-
tap. 

Edit a grouped shape  

1. Select the group. 
2. To focus a shape within the group, touch the shape or swipe left and right to 

move through the shapes in sequence. 

Move a shape 

1. Select the shape. 
2. Double-tap and hold anywhere until you hear "Drag to move shapes."  
3. Drag your finger to move the shape. 

Rotate or resize a shape 

1. Select the shape. 
2. Swipe to move focus to one of the handles. 
3. Double-tap and hold until you hear the cue to drag to rotate or resize shapes. 
4. Drag your finger to rotate or resize the shape, or scroll four fingers over the 

handle. 

Crop an image 

1. Swipe to move focus to the image. 
2. Triple-tap to enter crop mode. 
3. Swipe to move focus to the crop handles. 
4. Double-tap and hold until you hear the cue to drag to crop the image. 
5. Drag your finger to crop the image. 

Use keyboard shortcuts 

If you use an attached keyboard with your iPhone or iPad, you can use keyboard 
shortcuts to navigate in the Docs app. For a list of iPhone and iPad shortcuts, refer 
to Docs shortcuts. 

Use a braille display 

In the Docs and Slides apps, you can use a braille display to read and enter text. Learn 
about braille support. 
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